
 
 

 

Job Seekers: Resumes and More 
 
 

Overview: Learn what O*Net Online and JobZone can do for you; use it to search for jobs, refine a 
resume, or ace the interview. Learn about Web Site security, too. Practice finding and using a variety 
of resume templates! 
 
Student Skill Level: Intermediate 
 
Requirements: Basic mouse skills (Ability to move the mouse around the computer screen with 
some assistance. Ability to “click” and “double click” the mouse as instructed during class) 
 
 
Objectives 

 Discuss security features common to web sites 
o View a secure web site 

 Use the NiogaMobile web site and find: 
o The O*Net Online resource 

 Use it look for possible employment  
 Beef up your resume with descriptions 

 Explore JobZone Web Site 
 Use Microsoft Word: 

o Find a resume template 
o Practice entering information 
o Learn to save your work 
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Technology Classes for You! 
 

Connecting NIOGA’s Communities 
 

www.niogamobile.tech www.nioga.org 

http://www./
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Web Browsers and Web Sites 

 
 
 
 
 
 
 
 
 
 
 
 
 

Open the Internet  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“Browsers are software programs that allow you to search for and view various kinds of information on 
the Web, such as Web sites, video, audio, etc.” (Boswell, 2008). 
 
Internet Explorer is one type of Web browser. There are many different kinds of browsers, but they 
function similarly. Examples include Firefox, Chrome, Opera, and Safari (Mac). 
 
Using a browser allows you to access Web pages which are stored on a server. Web page(s) make 
up Web sites. A single Web site may consist of one page to thousands of pages, just like books. 
 
Let’s open the Internet and look at the BTOP computer training web site. 
 

There are two ways to open the Internet: 
 
Double click on the icon on the desktop    OR 

 
Click once on the icon and then press the Enter key on the keyboard 
 
The icon will turn white and then a small circle will appear on the screen as the 
computer works to open the program 

 

The anchor page of ANY Web site is called the Home page. It is the starting point of the site, much like 
the cover of a book. A good Home page will have an easy-to-remember web address (like 
www.niogamobile.tech), introduce you to the company or person who owns the site, and will clearly 
point the way to additional pages in the site – like the table of contents in a book. 
 
If you know the Home Page address of a Web site, it’s very easy to find the site! 
 
Here’s a portion of the Home Page: 
 

 
 

We see the NIOGA logo, introducing us to the owner, and multiple hyperlinks. Those are elements in a 

Web page that allow users to see new items or Web pages. Your mouse indicator will change its 

shape to a hand when you move it over the link. Links may be words, images, or animation.  
 
 

http://www.niogamobile.tech/
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Secure Web Site Example 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

I want to point out the standard security features of this site. Not every Web site NEEDS to be secure. 
It’s only very important when you are giving out personal information – name, social security 
number, etc. It is imperative that you check a site’s security BEFORE you enter personal data – even 
from a well-known company.  
 

All legitimate businesses have a great interest in keeping your information secure. This is done by a 
two-part process: first, by ensuring that your computer is in fact connected to the correct server (in 
this case, Tops) and second, by scrambling data sent over the Internet in such a way that if anyone 
tried to steal it, all they would find is meaningless, random information.  
 

You can see that Tops secures your personal data by seeing the “S” after the http (Hypertext Transfer 
Protocol) in the Address bar. This indicates a secure transaction through encryption (data scrambling) 
so that no one else may see it. 
 

There is a padlock at the end of the Address bar. Click the padlock to view the company’s Security 
Certificate. 
 

 

Here is the identification drop down window. 
VeriSign is a well-known computer security firm 
and has been in business for over 25 years and is 
a trusted name. 
 
This is the Connection tab in the drop down 
window. This is important because it tells us the 
encryption rate (how much the data is 
scrambled). This one says 256-bit encryption. 
This is important, because the higher the number, 
the harder the connection is to crack. 
 
Right now, there is 128-bit and 256-bit encryption 

for residential use. 256 is better. 

Click once on the Certificate information link to view the security certificate. 
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O*Net Online Resource 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Here is the certificate itself. The Valid 
from: dates are the most important part of 
the certificate and they should be current. 
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JobZone from the New York State Deptartment of Labor 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The NYS Department of Labor has a 
workforce development site as well. It has 
more online resources, and a place to log in 
with an account, as well.  
 
Go to www.jobzone.ny.gov 
 
This is the upper corner of the first page. To 
access all the resources, you need to sign in 
with your account. 
 
Your job counselor has created an NY.gov 
account for you. It’s in your paperwork (if you 
don’t know your login, ask your counselor). 

This is the opening page of JobZone. You may click on any of these choices and explore the 
possibilities. 

http://www.jobzone.ny.gov/
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This is the bottom part of the page. 

Connection is secure! 
 

 

Take some time to explore 

the options available to you 

on JobZone!  
This is at the bottom of each page. 
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Job Search Tips: A Summary 

 
Angela Colley created a useful step-by-step guide to searching Craig’s List for jobs. Here are the 
highlights, applicable to any job search: 

 Use JobZone to narrow your focus – your strengths and interests, and the general location 
where you’d like to work. Do you want to work from home? That’s an option, but you need 
high-speed Internet and computer skills. 

 Make sure you read the ad description. Searches usually cast a very wide net, and if you find 
something you really like, be sure it’s geographically correct. Colley states, “Make sure you 
look beyond the first 100 listings as the later ones could have the fewest applicants!”  

 Remember the old adage, “If something sounds too good to be true, it probably is.” 

 Write and re-write your resume. Be “sure it has all relevant information regarding your job 
history, education, licenses, and any special awards or acknowledgments – the stuff 
employers really want to see. Definitely include any marketable skills that will make you stand 
out against the competition, such as if you’re bilingual or proficient in certain programs 
pertinent to your field. Keep your resume short and pointed, and use “action” words” (Colley, 
2012). 

 Use your cover letter as an opportunity to round out your skills highlighted in the resume. You 
might include some information to explain gaps in your work history, but don’t get too 
personal. If a gap is relevant to the job you’re applying for, as in, you took care of an aging 
parent and you’re applying for a heath care job, then you might include this information. Keep it 
short! 

 Do respond quickly to any communication from the employer. 

 Email addresses should be professional. Many businesses have their own domains, but not 
all. Make note of any special instructions when sending a resume and cover letter. 

 Include your resume as an attachment and use the correct file extension. That should be 
covered in the job advertisement. If no specific format is stipulated, use .pdf. 

 Don’t apply if it sounds too good to be true. Colley writes, “if an ad doesn’t sound 
legitimate, it’s probably not. If it includes the name of the company, however, you can Google it 
before you send your resume. Otherwise, you may want to move on to the next ad.” 

 Use Social Networking of all kinds to help you land your job. Referrals are very important, as 
are references. Referrals get you in the door of the employer, and references tell the employer 
you can do the job. Use in-person and online networks. Pick a social network and use it daily. 
If you use LinkedIn (this is my best recommendation for you as it is geared to professional 
social networking), take a class on it. There are all kinds of excellent features you may use to 
build your network! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
Facebook  Twitter 
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Free Online Typing Tutorials 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resume Templates: Word Practice 
 
Once you start typing, you’re going to want to edit your resume. Microsoft Word has safe templates 
you may search for and use. Open Word and you will see the following: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There are many different typing tutorials on the Internet. Let’s look at some of the free ones available. 

 

Use any search engine, like Google, and type in “free online typing practice.” Pick one and try it! 

 

 

Click on 
Resumes and 
Cover Letters 
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Choose the Modern Chronological Resume and click Create. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Word will 
search for 
templates 
and display 
them for 
you. 
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First click on the paragraph mark on the Home Tab. This will show all the hidden formatting marks in 
Word and allow you to more easily edit any document! 
 

 
 
 
 
 
 



11 
There are many hidden characters and formatting marks in Word. Each one means something 
different and allows you to manipulate the document in certain ways. Becoming familiar with these 
marks can greatly assist you in creating any file in Word. The following items come from Barnhill and 
Rado’s article on formatting marks (2011): 
 
The paragraph mark or pilcrow (¶) represents a paragraph break (when the Enter key is pressed). 

A∙ small∙ raised∙ dot∙ represents∙ an∙ ordinary∙ space (Space bar is pressed). 

An arrow pointing to the right → represents a tab character (Tab key is pressed) 

In table cells you will see a circle with four lines radiating from the corners. ¤  [When you move your 

mouse to the top of a table] you will see a four-way arrow, usually blue in color.  This tells you 
where the table begins (very important; with one click you select the whole table, more later). 

Another very important nonprinting character is the anchor symbol – when working with floating 
objects it's often crucial to know where these are (We’ll see these with text boxes) 

  

Other, less important formatting marks are:  
 
A right-angle arrow pointing to the left represents a line break. 

A right-angle arrow between two vertical lines represents a text-wrapping break (intended for web 
pages) 
Manual Column, Page, and Section Breaks: 

 

 

 

Finally, you will sometimes see a small black bullet in the margin next to a paragraph. 

This indicates that the paragraph is formatted with the “Keep with next,” “Keep lines together,” 
“Page break before,” or “Suppress line numbers” property. 

It’s very important to keep these formatting marks in the template as you use it. If you don’t, you’ll 
lose the “look” of the document and hence negate the value of using the template. Place your cursor 
carefully and use the backspace and delete keys judiciously. If you accidentally lose a formatting 
mark, use the Undo button in the Quick Access toolbar at the top of Word.  
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Inserting a table in a document is one of the easiest ways to create even columns. Almost every 
resume template has some sort of table in it, so let’s take a quick look at one. 
 
Find the start of the table by locating the blue, 4-way arrow at the table’s beginning. Move the mouse 
around the page carefully; it will appear when your mouse is at the start of the table. Click once 
directly on top of the blue arrow and your entire table will turn blue (selected) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Saving a Document – Save Early and Save Often! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Go to the Home tab (at the top of your 
screen), in the Paragraph group, and 
click on the drop-down for Borders. Click 
on All Borders. What happens? 
 

The easiest way to save a document is to use 
the Quick Access Toolbar located directly 
above the File Tab at the top of the window. 
 
Click the Save Button  
 
 (You may also click the File Tab and then click Save) 

 

If this is the first time you are saving a document, the Save As dialog box will appear on the screen: 
 
 

 

1 

2 

3 
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Generally, I’d recommend Word templates as they are safe – no one else is getting any sensitive 
data. If you’d like to use an online resume builder, there are many to choose from, but remember your 
data security! Use the search engine of your choice:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Remember security before you begin entering any information!  

You need to tell the computer the following 
information: 
 
1. Where to Save: choose a location from the left side 

of the dialog box (removable disk) 
 
2. File name: type in your own file name and 

remember this so you can find the document again! 
 
3. Save as type: generally leave this as the default, 

though sometimes it needs to be changed. If you 
find this to be the case because of compatibility 
issues (using older and newer versions of the 
software) click the drop-down menu and choose a 
type: NOTE THIS IS WHERE YOU MAY SAVE AS 
A PDF FILE TYPE! 

 

Once you have completed the Save As dialog box once you don’t need to repeat. When you click the 
Save command (either from the Quick Access Toolbar or the File Tab) you will automatically 
overwrite changes to the original document.  
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Resources 
**These items are available in the NIOGA Library System!** 

**Contact your local library for assistance!** 
 

 

Author Title 

Kursmark, L. 30-minute résumé makeover : rev up your résumé in half an hour 

Lambert, J. Microsoft Office step by step (Office 2021 and Microsoft 365) 

Weverka, P. Office 2021 all-in-one for dummies 

Whitcomb, S. Résumé magic : trade secrets of a professional résumé writer 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Computer Training Program is provided by: 
 

    

Edited 2023 
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